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Figure A-1: The Free-Fall HyperPro 
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Purpose 
The HyperPro is a lightweight profiling device available as a standard free-fall 
profiler or mounted on a lowering frame. 
 
See Figure A-1, The Free-Fall HyperPro 

 
The HyperPro is specifically designed to use the new hyperspectral OCR-3000 
series optical sensors to provide a versatile profiling platform for measuring the 
apparent optical properties of the ocean. The system addresses the issues of self-
shadowing and ship induced disturbances while offering a wide dynamic range in 
an easy to deploy package. 

Background 
The primary goal of the HyperPro design was to allow data to be collected with a 
high spatial resolution in the regions around a field station on a typical 
oceanographic cruise.  A secondary goal for the instrument was to support 
experiments in case-2 waters that are often found in the near-shore and littoral 
environments.  Water conditions in these areas are such that light levels below 
100 meters depth (generally below six optical depths) are extremely low, difficult 
to measure, and provide little significant information in terms of the satellite 
validation mission being performed. In addition, attenuation levels are high 
enough that it becomes important to have downwelling irradiance and upwelling 
radiance sensors located close to the same depth.   
 
The HyperPro design builds on the experience gained by Satlantic on previous 
generations of profiling instruments.  Significant improvements have been made 
in size and weight reduction, and the system electronics has undergone a high 
degree of integration.  The HyperPro utilizes the OCR-3000 series of digital 
optical sensors in a networked configuration, greatly increasing the systems 
versatility and flexibility. 

Features 
• Available as a free-falling profiler or on a lowering frame 
• Small package 
• Lightweight 
• Easily deployed 
• Low power requirement 
• Minimal amount of surface equipment required 
• Easy to use 
• Uses Satlantic“s OCR-3000 MiniSpec Hyperspectral Radiometers in a 

network configuration 
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Figure A-2: HyperPro System Block Diagram 
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HyperPro System 
 

The HyperPro system can be viewed as a grouping of modules.  This modular 
design greatly increases the system's versatility and re-configuration potential.   
The basic modules are the system power module, the master module, the 
ancillary slave module and the optical sensor slave modules. 
 
See Figure A-2,  HyperPro System Block Diagram 
 
The system power module is comprised of a 12 volt (nominal) DC power supply, 
usually a battery, and Satlantic's MDU-100 deck unit.  Another deck unit with the 
same capabilities as the MDU-100 may be used.  The DC power supply delivers 
a voltage in the range of 10 - 20 V dc to the MDU-100 deck unit where it is 
converted to 48V and sent through the power/telemetry cable to power the 
HyperPro.  The deck unit also converts RS-422 telemetry from the HyperPro to 
RS-232 levels so that it can be sent to the computer. 
 
The main housing of the HyperPro body contains the master module and the 
ancillary slave module.  The master module is a microcontroller that uses a 
common two-wire bus to communicate with the slave modules.  The master 
module's responsibilities are: 
• To coordinate network access 
• To issue sample commands to the slave modules 
• To retrieve data from the slave modules 
• To broadcast the data frames on the serial up-link 

 
The ancillary slave module is also a microcontroller in the main housing of the 
HyperPro body.  The ancillary slave module may obtain measurements from 
pressure, tilt and/or temperature sensors. The ancillary module operates in a slave 
configuration, and responds only to commands from the master module to obtain 
data from its sensors.  Analog measurements with the ancillary module are made 
using an 8-channel precision 16-bit Analog-to-Digital Converter (ADC). 
 
On a typical system, two OCR-3000 slave modules are attached to the HyperPro 
body outside of the main housing.  These slave modules obtain and report data 
when requested by the master module. 
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Figure A-3: HyperPro Free-Fall and Frame Mounted types 
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Figure A-4: HyperPro Power/Telemetry External Interface 
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Major Components 
 

The major components of the HyperPro are the instrument body, sensors, deck 
unit, cables, power supply (typically a 12 volt battery) and computer. The user 
supplies the computer, and possibly the power supply.   

HYPERPRO INSTRUMENT BODY 
 
The modular design of the HyperPro allows the system to be configured in a 
number of ways.  Currently, the system can be configured by Satlantic to be 
either a free-falling profiler or mounted on a lowering frame.   
 
See Figure A-3: HyperPro Free-Fall and Frame Mounted types 

Free-Fall Type 
The HyperPro free-fall profiling design builds on the experience that Satlantic 
has gained in earlier generations of profiling instruments.  The primary advantage 
of this deployment technique is that it provides a straightforward method of 
making measurements away from the ship being used to deploy the instrument 
and away from the measurement errors that its shadows create.  With a main 
pressure housing diameter of only 48 mm and a weight of about 5 kg, this new 
design minimizes the size and weight of the profiler, allowing rapid deployment 
from even small inflatable boats.  The free-fall descent rate of the instrument is 
fixed at 0.3 m/sec. 

Frame Mounted Type 
Configuring the HyperPro for use on Satlantic's rugged stainless-steel lowering 
frame allows the irradiance and radiance sensors to be mounted in the same 
plane, if desired.  This is an ideal situation in waters with high attenuation levels.  
In addition, the frame configuration allows the user to suspend the HyperPro at a 
particular depth without concern for the vertical stability of the instrument, as in 
the case for the free-fall profiler. 
 

Power/Telemetry Cable Connection 
The instrument body is connected to the power/telemetry cable through an 
electrical connector, as shown in the Figure A-4: HyperPro Power/Telemetry 
External Interface.  There is also a mechanical connection between the 
instrument body and the power/telemetry cable to allow the HyperPro to be 
deployed and recovered without straining the electrical connection. 
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Figure A-5: OCR-3000 Miniature Hyperspectral Radiometer (MiniSpec) Sensor and Sensor Connectors 

 



SYSTEM 

HyperPro 
 
 

 
  

SECTION 
A.    OVERVIEW 

 

Revision: A Doc. No.: SAT-DN-00130 - Copyright ’  2001 by Satlantic -  Page: A-8 
 

SENSORS 
 

Specifications for any of the HyperPro sensors may be obtained by contacting 
Satlantic.  A brief description of each sensor is provided below. 

Optical Sensors 
The OCR-3000 MiniSpec sensors are configured as slave modules for use in the 
HyperPro system.  The main purpose of the OCR-3000 slave is to collect 
hyperspectral optical data.  These sensors are connected to the instrument body 
through the connector shown in the figure above.  Please refer to the OCR-3000 
Instrument Operation Manual for more details on the optical sensors. 
 
See Figure A-5, OCR-3000 Optical Sensor and Sensor Connectors 

Pressure Sensor 
The Entran Series EPXM pressure sensor is a small, ratiometric sensor providing 
an analog signal to the ancillary module's ADC.  This pressure sensor provides 
accurate depth data (0.25% full-scale typical).  The EPXM series is available in a 
variety of pressure ranges and may be chosen to match the application. 

Tilt Sensor  
The HyperPro is available with a miniature bi-axial clinometer (tilt sensor).  This 
sensor provides an analog voltage representation to the ancillary module's ADC 
for tilt measurements in both the X- and Y-axes.   This sensor provides a linear 
operating range of 6458, with an accuracy of 0.28. 

Thermal Probe 
The HyperPro is available with an external thermal probe that is used to 
determine the water temperature TW.  The analog signal from the probe thermistor 
is linearized and then measured by the ancillary module's ADC.  The thermistor 
is thermally calibrated by Satlantic and provides 0.15% full-scale accuracy over 
an operating range of -2.58C to +408C. The thermal sensor is connected to the 
instrument body through the connector shown in the figure. 
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Figure A-6: MDU-100 Deck Unit 
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DECK UNIT 
 
The deck unit, MDU-100, serves as both a nominal 48 volt DC power source for 
the HyperPro and as a RS-422 to RS-232 level converter.  It is connected to the 
battery, the instrument body and the computer, through three connectors.  
Connector details are shown in the figure. 
 
See Figure A-5, MDU-100 Deck Unit 
 
A major design goal for the HyperPro was low-power operation.  Although 
power requirements vary with system configuration, a typical system has a 
steady-state current draw of between 1 and 1.5 amps at 12 VDC into the MDU-
100.  This is a power requirement of 12-18 watts. If you are planning on using a 
power supply instead of a battery to power the MDU-100, the supply should be 
capable of at least 3 A to guarantee reliable operation. 
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Figure A-7: Cables 
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CABLES 
 

The Power/telemetry cable runs from the deck unit to the instrument body. 
 
See Figure A-7: Cables 

 
The power/telemetry cable acts as a mechanical and electrical tether, providing a 
flexible, high strength connection between the vessel and the instrument and 
providing a channel to transport telemetry to the deck unit. The cable weighs 
700g/100m in water.  The mechanical terminations can withstand 750kg of 
tension and prevent electrical termination damage and instrument loss.  

 
The Supply Cable or Battery Cable runs from the battery to the deck unit.   
 
The RS-232 Cable runs from the deck unit to the computer.   
 
The Interconnect Cables, typically one for each sensor depending on the 
system, connect sensors to the main housing on instrument body.   

 

POWER SUPPLY 
 

The power supply is normally a battery, but may be any dc power supply in the 
range of 10-20 VDC at 3 A. However, in a battery-powered system we 
recommend using a fairly large battery (i.e. 50 Ah gell cell).  This allows a laptop 
computer to use the same power supply as the HyperPro. 
 

COMPUTER 
 

The user must supply a computer in order to view and log HyperPro telemetry.  
SatView, Satlantic's data logging and display program, should operate on any 
IBM compatible computer running Windows 95 or 98 with 5 MB of free disk 
space and a free RS-232 serial port (additional ports are required for reference 
instruments).  Additional disk space is required to log data from the HyperPro - 
allow several Megabytes.  Please refer to the SatView manual for more details. 
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Figure A-8: Telemetry Data Frames 
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Telemetry Format 
 

Telemetry from the HyperPro is organized into frames.  The HyperPro provides a 
frame synchronization string or "header" (a "unique" sequence of bytes) to allow 
Satlantic software to detect the beginning of a data frame.  The frame itself 
consists of a number of binary data "fields", as defined by the HyperPro's 
calibration file.   
 
See Figure A-8: Telemetry Data Frames 

 
The HyperPro's data frame is actually a macroframe, assembled from several 
subframes.  The subframes are the data frames from the slave devices on the 
network.  For this reason, the size and format of the macroframe will change 
from one HyperPro instrument to another, depending on how the MiniSpecs are 
configured.  The macroframe can be more easily understood if the individual 
subframes are looked at individually. 
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MASTER FRAME 
 

The master frame is the data from the master controller in the HyperPro.  The 
master's data frame format will not change with the instrument configuration. 

 
Field Field 

Size 
(bytes) 

Field Name Description 

1 10 HEADER The frame synchronization string marking 
the beginning of the data frame.  The first six 
characters denote the type of instrument 
(SATNPR for Satlantic Hyperspectral 
Profiler) followed by the instrument's 4 digit 
serial number. 

2 2 SV-NPR This sensor represents the system“s internal 
voltage. If this voltage for some reason does 
not remain constant, there may be a problem 
with the instrument and sensor data integrity 
should be considered compromised. 

3 1 FRAME COUNTER Frame counter that increments with each 
frame sent, from 0 to 255.  When 255 frames 
are sent, the counter resets to 0.  The frame 
counter is a useful tool for determining when 
and where data loss occurs. 

4 10 TIMER This sensor indicates the number of seconds 
elapsed since the instrument was first 
powered up and telemetry output began. The 
value of each reading coincides with the 
beginning of the sensor-sampling period. 

5 1 CHECK SUM Causes sum of bytes in this frame to be 0.  
May be useful for later error checking. 

6 2 CRLF Carriage return and line feed terminator. 
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ANCILLARY FRAME 
 

Field Field 
Size 
(bytes) 

Field Name Description 

1 10 HEADER The frame synchronization string marking 
the beginning of the data frame.  The first six 
characters denote the type of instrument 
(SATPNC for Satlantic Profiler Ancillary) 
followed by the instrument's 4 digit serial 
number. 

2 2 V ANALOG Voltage rail measurement of the analog 
sensor components. 

3 2 V ENTRAN Voltage rail measurement of the ENTRAN 
pressure sensor. 

4 2 T PCB Temperature measurement of the controller 
board. 

5 2 AUX1 Unused 16-bit ADC channel.  
6 2 AUX2 Unused 16-bit ADC channel.  
7 2 AUX3 Unused 16-bit ADC channel.  
8 2 PRES 16-bit measurement of Entran pressure 

sensor, if present 
9 2 TILT X 16-bit measurement of x tilt sensor, if present 
10 2 TILT Y 16-bit measurement of y tilt sensor, if present 
11 2 TEMP TILT 16-bit measurement of tilt sensor temperature 

(if present). 
12 2 T W 16-bit measurement of water temperature, 

from external thermistor (if present).  
13 4 FRAME COUNTER 4 byte frame counter. 
14 10 TIMER This sensor indicates the number of seconds 

elapsed since the instrument was first 
powered up and telemetry output began. The 
value of each reading coincides with the 
beginning of the sensor-sampling period. 

15 1 CHECK SUM Causes sum of bytes in this frame to be 0.  
May be useful for later error checking. 

16 2 CRLF Carriage return and line feed terminator. 
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OPTICAL SENSOR FRAMES 
 
For information on the OCR-3000 MiniSpec frame format, refer to the OCR-
3000 Instrument Operation Manual. These instruments are pre-configured by 
Satlantic for use in a HyperPro. 

 

DATA FORMAT 
 

The HyperPro data format is fixed at 57600 baud with no parity, 8 data bits, and 
1 stop bit.  No hardware handshaking is used.  Data transmission should be 
automatic when the power is applied to the instrument, after a short delay. 
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B. SAFETY & HAZARDS 
 

Ø The operators of the profiler and reference should always remain aware of 
the cable.  Any cable or line released from a ship can be dangerous.  Keep a 
safe distance from the cable coil on deck when the instruments are being 
used. 

 

Instruments 
 

Ø Do not leave instruments in direct sunlight on deck when not in use.  
Extreme heat (35°C or greater) can potentially damage them. 

 
Ø Closely monitor depth during profiler casts to ensure that depth changes do 

not cause the profiler to contact the ocean floor when in shallow water or 
exceed the system depth rating when in deep water. 

 
Ø When using an in-water reference with the HyperPro, do not leave the 

reference unattended.  Boat drift can entangle the cable and cause damage or 
instrument loss. 

 

Cable 
 

Ø Ensure the power/telemetry cable is not pinched or bent to a radius less than 
18 cm, to prevent damage to the conductors within the Kevlar strength 
member. 

 

Connections 
 
Ø Handle electrical terminations carefully, as they are not designed to 

withstand strain.  Disconnect the cables from the components by pulling on 
the connector heads and not the cables.  Do not twist the connector while 
pulling, as this will damage the connector pins. 

 
Ø Do not use petroleum-based lubricants on connectors.  Connectors should be 

free of dirt and lightly lubricated before mating.  We recommend using DC-
111 silicone grease (made by Dow-Corning) on the male pins prior to 
connection. 
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Deployment 
 

Ø When using a block to let the cable out during deployment, ensure the gap 
between the roller and the housing is sufficiently small to prevent the cable 
from skipping off the roller and getting caught or damaged. 

 
Ø Take care to prevent the power/telemetry cable from being drawn into the 

vessel's propellers or thrusters when maneuvering.  The cable weighs only 
700g/100m in water but will sink and is very strong and extremely difficult 
to cut.  

 

Troubleshooting 
 

Ø While checking voltages with a multimeter, extreme care should be used so 
as not to short the probe leads.  A shorted power supply or battery can output 
many amperes of current, potentially harming the user, starting fires, or 
damaging equipment. 

 

Recovery 
 

Ø Remember never to grab the electrical portion of the profiler or reference 
cable during recovery.  This can cause damage to the power/telemetry 
bulkhead and the underwater splice. 

 
Ø Lens caps should always be replaced as soon as the instrument comes back 

on board.  This will help protect the heads from direct damage. 
 

Ø Always disconnect the 10 - 20 Vdc power source (i.e. the battery) from the 
MDU-100 before disconnecting the power/telemetry cable from the 
HyperPro. 

 
Ø Be sure to rinse the instrument with fresh water prior to storage.  Corrosion 

resulting from failure to do so is not covered under warranty. 
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Figure C-1: Frame Mounted Assembly 
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Assembly Procedure 
 

PREPARATION 
 

In preparation for assembly, the HyperPro components should be checked against 
the packing list to ensure that all required items are included.  There may be 
additional interconnect cables, weights and other supplies packed with the 
instrument.  The dummy connectors and the optical sensors' vinyl end caps 
should be removed and stored so that they can be replaced after the HyperPro is 
recovered.  The instrument packing should be retained and reused to prevent 
instrument damage during transport.  
 
A user supplied computer, and possibly also a power supply is required.  These 
can be unpacked and set up for connection to the HyperPro. 
 
Additionally, lubrication for the male pins prior to connection is required.  We 
recommend DC-111 silicone grease (made by Dow-Corning).  Do not use a 
petroleum base lubricant.  If the frame mounted HyperPro is being used, the 
deployment apparatus should be set up for operation. 
 

CONNECT THE COMPONENTS AND CABLES 
 
Connectors should be inspected to ensure they are free of dirt and then lightly 
lubricated before making connections.  Connect the instrument body, the 
computer and the battery to the deck unit, as follows. 
 
1. Mount any sensors to the instrument which are not already in place.   If the 

HyperPro is not already fully assembled, usually only the optical sensors 
require mounting.  For the free-falling configuration, the sensors are attached 
with positive locking quick release pins and secured with cable ties.  For the 
frame mounted instrument, the optical sensors are locked into position by an 
index pin and secured with a cable tie.  The instrument body is then cable 
tied to the frame, as shown in the figure. 

 
Figure C-1: Frame Mounted Assembly. 
 
2. Mount the two buoyancy cans to the bottom of the rails along the center axis 

of the instrument with the provided cable ties (see figure C-2). 
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Figure C-2: Position of buoyancy cans.  
 
 
3. Connect the sensor cables on the instrument.  Ensure the connectors match 

before attempting to connect them.  There are different connectors for 
different sensors to ensure they are connected properly. 
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Power/Telemetry Cable 

To HyperPro 

Electrical Termination (MCIL-6F) 

Electrical Splice 

Eye 
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Mechanical Splice 

Electrical Termination (IL-4M) 

Electrical Splice 

Eye 

Shackle 

To MDU-100 

To secure point on vessel 

 
 
 
 

Figure C-3: Power/Telemetry Cable Connections 

 
 

 
4. Connect the power/telemetry cable to the instrument.  First connect the cable 
shackle to the instrument shackle and then connect the six pin electrical 
termination to the instrument.  The shackle on the other end of the 
power/telemetry cable may then be connected to a hard attachment point on the 
vessel. 



SYSTEM 

HyperPro 
 

 
  

SECTION 
C.    START UP 

 

Revision: A Doc. No.: SAT-DN-00130 - Copyright ’  2001 by Satlantic -  Page: C-5 
 

 
See Figure C-3, Power/Telemetry Cable Connections 

 
5. Connect the power/telemetry cable to the deck unit. 
 
6. Connect the RS232 cable to the deck unit and computer. 

 
7. Connect the deck unit to the battery.   

 
8. Turn on the computer. 

 

CONDUCT A SIMPLE TELEMETRY TEST 
 

A simple telemetry test should be conducted to get familiar with the data logging 
software and to test the system for proper operation prior to deployment.  
HyperPro data can be viewed in real time and logged using SatView, Satlantic's 
Windows'95/98 based data logging and display software package.  SatView is 
provided with the HyperPro on two 3.5" diskettes.  The calibration files, on a 
3.5" diskette, are also provided. Load the SatView program and copy the 
calibration files onto the computer prior to the test outlined below. 
 
Note: The procedure outlined below is for use with Satlantic“s MicroPro. The 
MicroPro is the multi-spectral version of the HyperPro. Although the procedure 
is generally the same, windows will appear slightly different when used with the 
HyperPro. 
 
1. Start SatView by selecting Start -> Programs -> Satlantic -> SatView.  

You should see: 
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2. Select Setup -> Resource List, as shown: 
 

 
 

3. In the Communications Resources dialog, select the add button to add the 
communication port that will be used to log data.  Here, COM1 is assumed.  
Setup the port for 57600 baud, as shown. As the HyperPro frame rate is 
considerably slower the its multi-spectral cousin, the Wait Timeout parameter 
should be increased to about 3000 msec or more. 
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4. Select OK, then click the Display button in the Communications Resources 
dialog.  You should see the COM1 Control Panel, as shown.  Drag the 
window to a convenient location on the desktop, and close the 
Communications Resources dialog box. 

 

 
 
 

5. Next, you need to set up SatView with the calibration files supplied with the 
HyperPro.  The calibration files you receive will be different than that shown 
here, but the procedure is the same.  There should be 6 calibration files 
associated with your system. Although the order in which they are added to 
SatView is not important, the following order is suggested: Master, 
Ancillary, MiniSpec 1 Light, MiniSpec 1 Dark, MiniSpec 2 Light, MiniSpec 
2 Dark. Select Setup -> Add Instrument. 
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6. You should see the Add New Instrument dialog box.  Select From 
Calibration File, and browse to the location of your calibration file, as 
shown.  The name and location of your calfile will be different from that 
shown in the dialog. 

 

 
 
 

7. The main SatView window should now appear as follows (there will be six 
instruments in the list for a HyperPro): 
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8. Right-click on the Ancillary ”instrument„ in the instrument list 
(SATPNCxxxx) and select Properties.  Set up the dialog as shown. Make 
sure the Instrument Type is set for PROFILER as this will be needed to do a 
pressure tare. Also, make sure the Check Sum Error Checking check box is 
enabled. 

 

 
 

9. If you are using a port other than COM1, select it from the drop down list.  
Select OK to close the dialog. 

 
10. You may now open display panels for each of your ”instruments„. Double 

click on any instrument in the list to open the instrument“s Control Panel. 
The following is a typical example: 
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11. Double-click on each of the views in the view list to display the data for that 

view.  Arrange the windows as is convenient on the desktop. 
 

12. As an extra convenience, SatView allows you to save this setup for the next 
time you use the HyperPro.  Go to File -> Save As and save the setup in a 
convenient location with a descriptive name, such as "HyperPro.sat" in the 
SatView directory.  The next time you wish to use the HyperPro with 
SatView, simply open this file and all settings will be restored.  Please refer 
to the SatView manual for more details. 

 
13. Shown on the next page is a typical SatView session. 
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D. OPERATION 
 

+ - 

A typical HyperPro deployment.  Note objects are not shown to scale.  

HyperPro in free-fall configuration 

Computer 
Battery 

MDU-100 

Research 
Vessel 

Cable 
Mechanical 
Termination 

 
 
 

Figure D-1: Free-Fall Deployment 



SYSTEM 

HyperPro 
 

 
  

SECTION 
D.    OPERATION 

 

Revision: A Doc. No.: SAT-DN-00130 - Copyright ’  2001 by Satlantic -  Page: D-2 
 

Deployment Procedure 
 

FREE-FALL DEPLOYMENT 
 
The primary advantage of the free-fall deployment technique is that it provides a 
straightforward method of taking measurements away from the ship being used 
to deploy the instrument and away from the measurement errors that its shadows 
create.  The instrument is suspended on a cable and lowered alongside the vessel. 
The drop rate on the free falling HyperPro is fixed at about 0.30 m/s. 
 
See Figure D-1: Free-Fall Deployment 

 
The HyperPro instrument should be used at a minimum distance of 20 m from 
the boat.  The HyperPro should be carefully lowered to the water by slowly 
releasing the cable.  If the boat is drifting, the HyperPro can be set in the water 
on the windward side and held to the surface by the cable until it is far enough 
away to drop.  If the boat is not drifting, the HyperPro should be set in the water 
at the stern so the boat propulsion can adequately separate the instrument from 
the boat.  If there is difficulty in getting the instrument to move away from the 
boat, connecting the power/telemetry cable lower on the instrument may be 
helpful. 
 
When the instrument is sufficiently far from the boat, the cable may be used to 
hold the instrument in position for the pressure tare.  A pressure tare is usually 
performed with the irradiance sensor just below the surface of the water. 
Although it is not necessary to make a pressure tare on every cast, the instrument 
should be held in this position before every cast begins for about 10 to 15 
seconds to allow the integration times of the MiniSpecs to settle to an appropriate 
level. 
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INCORRECT CORRECT

 
 

 
Figure D-2: Frame Mounted Deployment 
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FRAME MOUNTED DEPLOYMENT 
When using the frame mounted HyperPro, the length of the boom used dictates 
the distance that the instrument can be deployed from the boat.   The complete 
avoidance of ship shadow is mandatory for all radiometric measurements to be 
incorporated into the SeaWiFS validation and algorithm database.  The minimum 
deployment distance away from the ship can be calculated as per instructions in 
the "SeaWiFS Technical Report Series, Volume 25, Ocean Optics Protocols for 
SeaWiFS Validation", by James L. Mueller and Roswell W. Austin.  This 
document is included with the HyperPro but is also available from the NASA 
Center for AeroSpace Information, 800 Elkridge Landing Road, Linthicum 
Heights, MD 21090-2934, (301)621-0390.  The instrument should be deployed 
from the sunny side of the boat.  When deploying from the stern, the boat should 
be positioned so that the instrument can be deployed from with the sun's relative 
bearing aft of the beam.  Boom deployments are generally performed from either 
the port or starboard side of the boat.   
 
See Figure D-2: Frame Mounted Deployment 

 
First the power/telemetry cable should be wound onto the cable block, ensuring 
the secure attachment of the vessel end to a hard attachment point on the boat and 
the instrument end to the lowering harness of the frame.  The block should ensure 
that the cable cannot skip off the roller and get caught.  The instrument can then 
be guided over the side of the boat and lowered into the water.  Before lowering 
the frame, ensure that the lowering harness connectors are seated properly in the 
eyebolts, as shown in the figure.  When the instrument is in position, with the 
irradiance sensor just below the water's surface, it is ready to conduct a pressure 
tare. 

Conducting a Pressure Tare 
Two operators are required to deploy the free falling HyperPro, one to operate 
the computer and one to handle the instrument.  The operators will need to 
communicate with each other during deployment, so if they are out of hearing 
range, radios or another communication means will be required.  
 
The pressure tare is conducted to zero the pressure sensor.  When the instrument 
is in position with the irradiance sensor just below the water's surface, the 
operator handling the instrument informs the operator on the computer to 
perform the pressure tare.  From the Ancillary View in SatView, click on the 
Sensor button, and then click the Pressure Tare button for the Ancillary 
instrument.  The computer operator then informs the instrument operator that the 
pressure tare has been completed and that the system is ready for logging.  Please 
see the SatView manual for more information. 
 
After the pressure tare has been conducted, the instrument may be lowered if 
frame mounted or dropped if it is free falling.  The instrument operator informs 
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the computer operator when to start logging so that the required data is obtained. 
The instrument operator will then pay out the cable until the desired depth is 
reached before informing the computer operator to stop logging data.  

 

Logging Telemetry with SatView Software 
 

1. SatView provides a very simple method for logging HyperPro telemetry.  
After setting up SatView as described in the Start Up section, select Log -> 
options from the main SatView window.  The Logging Options dialog 
should appear. 

 

 
 

Set the logging mode to NONE, set the Append Time Tag check box, and set 
the log directory as desired.  The window should appear similar to that 
shown.  Select OK when complete. 

 
2. In the SatView main window, click the Edit button next to the Next Log 

field.  Type a name for our test log file, say HyperProTest, then hit enter 
(SatView will append .raw to the file name by default). 
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3. The Start Logging button is now available in the SatView window.  When 
you are ready to begin logging, simply click this button.  The log button 
should change to Stop Logging, and the Log Timer field will show how 
long SatView has been logging data.  In the Control Panel window, the 
Frames Rec. (for frames recorded) field should be incrementing.  When 
sufficient data has been logged (3 - 5 minutes) simply click the Stop 
Logging button. 

 

 
 

As shown here, the logged raw file is present in the selected directory.   
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SatView provides many more telemetry logging options that are beyond the 
scope of this manual.  Please refer to the SatView manual for more detailed 
instructions. 

 

Data Processing with SatCon Software 
 

After logging telemetry with SatView, the HyperPro data is stored in 
uncalibrated digital counts.  Satlantic's SatCon data processing software is 
provided for converting the raw log file into a text format.  SatCon reads the 
instrument calibration file, applies the appropriate conversion coefficients and 
formulae to the raw binary data and writes the data back out in calibrated 
physical units to an ASCII text file.   

 
Satlantic's ProSoft (version 7.0 and later) data processing software can also be 
used to process HyperPro data.  If this software is being used, please refer to the 
ProSoft manual for more details. 
 
This section outlines the procedure to conduct a simple SatCon session, assuming 
that the file HyperProTest.raw was logged as outlined above.  SatCon has a great 
number of features that are not discussed here; please refer to the SatCon manual 
for detailed operating instructions. 

 
1. To start using SatCon, select Start -> Programs -> Satlantic -> SatCon.  

The main SatCon window should now be displayed, as shown below. 
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2. From the Conversion heading, select Parameters.  The Conversion 
Parameters dialog box should be displayed.  Set up the options as shown 
and enable Check Sum Error Checking, then click OK. 

 

 
 

3. From the Conversion heading, select File Naming.  The Output File 
Naming dialog should be displayed.  Set up the options as shown below.  
This configures the output ASCII file to be named based on the calibration 
file name concatenated with the logged data file name, with a .dat extension.  
Select OK when complete. 
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4. SatCon must be instructed as to where to look for  the calibration file and log 
file, as well as where to put the output file.  In this example, we will assume 
that the directory C:\MicroPro is being used.  From the main SatCon 
window, select View -> Properties.  The File List Properties dialog will be 
displayed.  First, select Log Files from the drop down list, and change the 
working directory to wherever the logged data is stored.  Don't exit the dialog 
yet. 

 

 
 
 

5. Select Instrument Files from the drop down list and again change the 
working directory to where the calibration file is stored.  Don't close the 
dialog box yet. 
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6. Select Output Files from the drop down list and once again change the 
working directory to where you want the converted file to be placed. 

 

 
 
 

7. When you are happy with these settings, click OK.  The main SatCon 
window should now look similar to the following: 

 

 
 

As you can see, the Log Files list contains the .raw file, the Instrument 
Files list contains the .cal calibration file(s), and there are no output files 
present since no conversion has been performed yet.  Since multiple .raw and 
.cal files can exist in the same directory, the user must single-click the 
appropriate .raw and .cal file so that they are highlighted as shown.  Notice 
that the Next: field contains the name of the output file that is about to be 
generated.   
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8. SatCon is now ready to convert the binary data into ASCII format.  From the 
Conversion heading, select Convert.    The SatCon Conversion dialog 
should be displayed, indicating the conversion progress, the number of 
frames processed, and any frame counter errors detected.  Click OK when the 
conversion is complete. 

 

 
 
 

9. The main SatView window should appear as shown.  Notice the converted 
log file is shown in the Output Files list. 
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10. If you check the destination folder, you can confirm that the .dat ASCII 
output file is indeed present. 

 

 
 

SatCon can now be exited and the output .dat file can be loaded into a 
spreadsheet or other data processing program. 
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E. RECOVERY 
 
To recover the HyperPro, terminate data logging and pull the instrument back in 
using the power/telemetry cable.   Take care not to jar the instrument, as the 
system may include sensors that are susceptible to shock damage.   
 
Always be sure to rinse the instrument with fresh water prior to storage in order 
to prevent corrosion. If seawater is allowed to remain in contact with the 
instrument in storage, particularly around bolts and other contacts of dissimilar 
materials, corrosion may occur. To not properly rinse the instrument before 
storage is considered misuse and warranty claims cannot be made under such 
circumstances. 
 
Remember to disconnect the input power supply from the MDU-100 before 
removing any other connections, and immediately replace the 2-pin dummy plug 
on the battery cable.  Disconnect the cables from the components taking care to 
pull without twisting on the connector heads, not the cables.  Ensure the dummy 
connectors are put back in place so that the male pins are not damaged and the 
female pins remain clean.  Replace the vinyl end caps on the optical sensors.  
Then the instruments may be stored in the packing boxes, ensuring they are 
packed properly to protect them from damage during transport. 
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F. MAINTENANCE 
 

Preventative Maintenance 
 

The HyperPro requires virtually no maintenance.  The life of the instrument will 
be prolonged by protecting it from impacts, rinsing it with fresh water after each 
use and properly storing the instrument with the dummy connectors and optical 
sensor end caps on when not in use. 
 
If the instrument is not working properly the following troubleshooting 
techniques can be followed.  If these are not successful, contact Satlantic for 
more information.  
 

Troubleshooting with HyperTerminal 
 

Occasionally, new SatView users may experience difficulty configuring the 
program properly in order to view and log HyperPro telemetry.  Windows'9x 
includes the HyperTerminal program for serial data communication.  This 
program provides a useful tool for quickly checking to see if telemetry is being 
received from the HyperPro. 

 

CHECKING FOR HYPERTERMINAL INSTALLATION 
HyperTerminal may not be installed on your computer.  It is, however, a standard 
part of Windows'9x.  Check to see if HyperTerminal is installed by entering 
Start -> Programs -> Accessories.  If a HyperTerminal folder is visible in the 
Accessories folder, HyperTerminal is already installed. 
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INSTALLING HYPERTERMINAL 
 

Adding HyperTerminal is very straightforward; open up the Control Panel and 
click on the Add/Remove Programs item. Go through the dialogs as shown to 
install the program. 
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CONFIGURING HYPERTERMINAL 
 

To start the HyperTerminal program, go to the Start menu and select Run, then 
type hypertrm in the Run dialog box. An alternative method is to enter the 
HyperTerminal folder through Start ->Programs -> Accessories -> 
HyperTerminal, then double-clicking on the hypertrm.exe icon.  At startup, 
HyperTerminal initiates a configuration with a new connection dialog box. It is 
helpful to create an informative name for the connection we are about to create, 
as shown in the following figure. The name as shown indicates that we will have 
a connection to the HyperPro, on COM1, at 57600 baud. 
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The phone number dialog box will then open. HyperTerminal is biased towards 
telephone and modem based connections, but for the HyperPro a direct 
connection is required. We need to avoid any automatic search by the program 
for a modem and select a direct COM port connection.  Below we see that Com 1 
has been selected. 
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Finally HyperTerminal will ask for the asynchronous serial port communication 
parameters that will be used in the connection. This is shown in the COM1 
Properties dialog box (below).  The properties required for the HyperPro are as 
follows: 57600 bits per second, 8 data bits, no parity, 1 stop bit, and no flow 
control.  You do not need to use the Advanced button in this dialog box (if 
present).   
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After completing this dialog and pressing the OK button, HyperTerminal's main 
window will be displayed, as shown below.  If the HyperPro has been assembled 
correctly and is turned on, the output telemetry stream should now be visible, as 
shown.   

 

Master Frame Header

Ancillary Frame Header

Sensor Frame Header

Sensor Frame Header (from
previous macroframe)
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At this point the connection will be established and it should be possible to see 
telemetry from the HyperPro.  However, the configuration process is not yet 
complete. The program is currently configured to auto-detect the type of terminal 
that it should be emulating. This is inappropriate for use with the HyperPro and 
may cause problems. To correct this, from the File menu you should click the 
Properties selection and change the terminal type. Select the Settings tab of the 
dialog box and change the Emulation from Auto Detect to TTY as shown.  
Setting the emulation type to VT100 also works well. 
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If the HyperPro has been set up properly, when you press the OK button you see 
telemetry as shown in the previous figure.  Notice that the master, ancillary, and 
sensor headers are all visible.  Sometimes you will not be able to see  some or all 
of the headers; this is often due to carriage return characters being present in the 
data frame, causing HyperTerminal to overwrite the headers.  Occasionally 
simply changing the emulation type to something else (such as VT100 instead of 
TTY) alleviates the problem.  If not, you can also append line feeds to incoming 
line ends.  From the same window where the emulation type was set, press the 
ASCII Setup button.  Check the box that says "Append line feeds to incoming 
line ends", as shown below.  This should allow you to easily see most headers. 

 

 
 

Troubleshooting for Hardware Problems 
 

If, after running Hyperterminal, telemetry is not visible in the HyperTerminal 
window, there could be a hardware problem.  The connections can be checked 
and voltage checks can be conducted on the cables and components, as outlined 
below. To check voltages, a multimeter with DC voltage measurement, resistance 
measurement, and continuity check capability is required. 

 
WARNING!  While checking voltages, extreme care should be used so as not to 

short the probe leads.  A shorted power supply or battery can 
output many amperes of current, potentially harming the user, 
starting fires, or damaging equipment. 
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CHECK CONNECTIONS 

Procedure 
1. Ensure power/telemetry cable is properly connected to MDU-100 and to 

HyperPro main housing. 
2. Ensure all sensor interconnect cables are in place and properly connected. 
3. Ensure power supply is properly connected to the MDU-100. 
4. Ensure RS-232 cable is connected to the correct PC communications port 

(COM1 in the example given) and to the MDU-100. 
5. Ensure no other programs are running that could be using the 

communications port. 

CHECK THE SUPPLY VOLTAGE TO THE MDU-100 
 

The MDU-100 deck unit is essentially a DC-DC converter.  An input voltage in 
the range of 10 - 20 Vdc is converted to a regulated 48 Vdc.  Voltages above the 
maximum input voltage of 20 Vdc may damage the MDU-100; voltages below 
the minimum operating voltage of 10 Vdc may cause the device to drop out of 
regulation.  Thus the user should ensure the voltage input to the MDU-100 is 
within the allowed range of 10 - 20 Vdc. 

Procedure 
1. Set the multimeter to measure a DC voltage. 
2. If using a battery as the power source, measure the voltage directly at the 

battery terminals with the multimeter.  A new or fully charged 12 V battery 
usually measures in the 13 - 15 V range.  If the voltage is low (under 11 V) 
then recharge or replace the battery.  If using a DC power supply, set the 
output voltage in the range from 10 - 20 V, and check the voltage with the 
multimeter. 

3. Connect the power supply cable to the power source. 
4. Being extremely careful not to short the probe leads, measure the voltage 

between pins 1 and 2 on the IL-2F connector (on the supply cable).  It should 
read approximately the same as the measurement taken in step 2.  If the 
voltages are not the same, recheck the power supply cable connections.  If 
they are still not the same, there is likely a break in the cable that requires 
repair (a wire break can be confirmed with a continuity check). 

5. If the voltage is ok, connect the power supply cable to the MDU-100. 
6. Again measure the voltage at the power supply terminals.  The voltage 

should remain approximately the same as before, although there may be a 
small voltage drop when using a battery (battery voltage drops under load).  
If there is a significant voltage drop, disconnect the power immediately and 
check for shorts in the cable. 
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CHECK THE OUTPUT VOLTAGE FROM THE MDU-100 
To check the output voltage from the MDU-100, a multimeter, as described 
above, is required.  As previously mentioned, the MDU-100 outputs a regulated 
48 Vdc (nominal) voltage.  Use the following procedure to check this voltage. 

Procedure 
1. Set up the MDU-100 input power as outlined in the MDU-100 Input 

Voltage Check section. 
2. Ensure the multimeter is configured to measure DC voltage. 
3. Being extremely careful not to short the probe leads, insert the negative 

(black) probe lead in Pin 2 and the positive (red) probe lead in Pin 1 of the 
BH-4F connector on the MDU-100.  The measurement should read 
approximately +48 Vdc.  If it does, the MDU-100 is operating properly.  If it 
does not, check all input connections to the MDU-100, and recheck the 
voltage.  Also ensure that you are measuring between pins 1 and 2, and that 
the probe leads are making contact with the pin metal.  If you still do not 
measure 48 V, the MDU-100 may need to be returned to Satlantic. 

CHECK CABLES CONTINUITY 
Often, system problems can be traced to cable breaks or shorts.  Usually, these 
cable failures are a result of improper handling or storage.  Cable continuity can 
be checked as outlined below. All cables should be disconnected from the 
instrument when performing these tests.   
 
Note: All Satlantic cables used in the HyperPro are one-to-one, that is, pin 1 on 
the connector on one end of the cable is connected to pin 1 on the connector on 
the other end of the cable.  On the power-telemetry cable, there is a 6-pin female 
connector on one end and a 4-pin male connector on the other.  The unused pins 
on the 6-pin (pins 5 and 6) are simply not connected. 

Procedure 
1. Set the multimeter to measure continuity.  The resistance measurement 

setting can also be used. 
2. Check for continuity by measuring from pin 1 on one end of the cable to pin 

1 on the other end.  The meter should confirm that the connection is 
continuous by either giving an audible signal or measuring a low resistance.  
If there is not continuity, there is a break in the cable, requiring repair. 

3. Repeat step 2 for all pins in the cable. 
Check for shorts from pin 1 to all other pins by keeping one probe lead on 
pin 1 and touching the other probe lead to each of the other pins in the same 
connector in turn.  All pins should be isolated from each other.  The meter 
should read this as open or measure a very high resistance.  If any of the pins 
are not isolated, there is a short in the cable that requires repair.  
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G. WARRANTY 
 
Warranty Period 
 

The HyperPro is under one-year parts and labour warranty from date of purchase.  
 
Restrictions 
 

Warranty does not apply to products that are deemed by Satlantic to be damaged 
by misuse, abuse, accident or modifications by the customer. The warranty is 
considered void if any optical or mechanical housing is opened. In addition, the 
warranty is void if the warranty seal is removed, broken or otherwise damaged.  

 
Provisions 
 

During the one year from date of purchase warranty period, Satlantic will replace 
or repair, as deemed necessary, components that are defective, except as noted 
above, without charge to the customer.  

 
Returns 
 

To return products to Satlantic, whether under warranty or not, contact Satlantic, 
Customer Support Department and request a Returned Material Authorization 
(RMA) number and provide shipping details. All claims under warranty must be 
made promptly after occurrence of circumstances giving rise thereto and must be 
received by Satlantic within the applicable warranty period. Such claims should 
state clearly the product serial number, date of purchase (and proof thereof) and a 
full description of the circumstances giving rise to the claim. All replacement 
parts and/or products covered under the warranty period become the property of 
Satlantic Inc. 

 
Liability 
 

IF THE HYPERPRO SHOULD BE DEFECTIVE OR FAIL TO BE IN GOOD WORKING 
ORDER THE CUSTOMER'S SOLE REMEDY SHALL BE REPAIR OR REPLACEMENT 
AS STATED ABOVE.  IN NO EVENT WILL SATLANTIC INC. BE LIABLE FOR ANY 
DAMAGES, INCLUDING LOSS OF PROFITS, LOSS OF SAVINGS OR OTHER 
INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING FROM THE USE OR 
INABILITY TO USE THE HYPERPRO OR COMPONENTS THEREOF. 
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H. CONTACT INFORMATION 

 
If you have any problems, questions, suggestions or comments about the 
instrument or manual, please contact us.  

 
Location 

Satlantic Inc. 
Richmond Terminal, Pier 9 
3481 North Marginal Road 
Halifax, Nova Scotia 
B3K 5X8 Canada 
 
PHONE: (902) 492-4780 
FAX: (902) 492-4781. 
 
Email: info@satlantic.com 
Web: http://www.satlantic.com 
 

Business Hours 
 

Satlantic is normally open for business between the hours of 9:00 AM and 5:00 
PM Atlantic Standard Time. The Atlantic Standard Time zone is one hour ahead 
of the Eastern Standard Time zone. Normally, in the winter, AST is UTC-4, but it 
changes to UTC&3 during the daylight saving time period in the summer. 
Daylight saving time is in effect from 2:00 AM on the first Sunday in April until 
2:00 AM on the last Sunday in October. 
 
Satlantic is not open for business during Canada“s statutory holidays, which are 
as follows: 
 

• New Year's Day  January 1st 
• Good Friday   The Friday before Easter Sunday  (Easter 

Sunday is the first Sunday after the full moon on or following March 
21st , or one week later if the full moon falls on Sunday) 

• Victoria Day   The first Monday before May 25th 
• Canada Day   July 1st 
• Halifax Natal Day  The first Monday in August 
• Labor Day   The first Monday in September 
• Thanksgiving Day  The second Monday in October 
• Remembrance Day  November 11th 
• Christmas Day   December 25th 
• Boxing Day   December 2 


